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Multiple sequence alignment

THEORY

Des Higgins and Philippe Lemey

3.1 Introduction

From a biological perspective, a sequence alignment is a hypothesis about homol-
ogy of multiple residues in protein or nucleotide sequences. Therefore, aligned
residues are assumed to have diverged from a common ancestral state. An exam-
ple of a multiple sequence alignment is shown in Fig. 3.1. This is a set of amino
acid sequences of globins that have been aligned so that homologous residues are
arranged in columns “as much as possible.” The sequences are of different lengths,
implying that gaps (shown as hyphens in the figure) must be used in some posi-
tions to achieve the alignment. The gaps represent a deletion, an insertion in the
sequences that do not have a gap, or a combination of insertions and deletions.
The generation of alignments, either manually or using an automatic computer
program, is one of the most common tasks in computational sequence analysis
because they are required for many other analyses such as structure prediction or
to demonstrate sequence similarity within a family of sequences. Of course, one of
the most common reasons for generating alignments is that they are an essential
prerequisite for phylogenetic analyses. Rates or patterns of change in sequences
cannot be analysed unless the sequences can be aligned.

3.2 The problem of repeats

It can be difficult to find the optimal alignment for several reasons. First, there may
be repeats in one or all the members of the sequence family; this problem is shown
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Human beta --------VHLTPEEKSAVTALWGKVN--VDEVGGEALGRLLVVYPWTQRFFESFGDLST
Horse beta --------VQLSGEEKAAVLALWDKVN--EEEVGGEALGRLLVVYPWTQRFFDSFGDLSN
Human alpha ---------VLSPADKTNVKAAWGKVGAHAGEYGAEALERMFLSFPTTKTYFPHF-DLS-
Horse alpha ---------VLSAADKTNVKAAWSKVGGHAGEYGAEALERMFLGFPTTKTYFPHF-DLS-
Whale myoglobin ---------VLSEGEWQLVLHVWAKVEADVAGHGQDILIRLFKSHPETLEKFDRFKHLKT
Lamprey globin PIVDTGSVAPLSAAEKTKIRSAWAPVYSTYETSGVDILVKFFTSTPAAQEFFPKFKGLTT
Lupin globin --------GALTESQAALVKSSWEEFNANIPKHTHRFFILVLEIAPAAKDLFSFLKGTSE

*: : : * . : .: * : * : .

Human beta PDAVMGNPKVKAHGKKVLGAFSDGLAHLDN-----LKGTFATLSELHCDKLHVDPENFRL
Horse beta PGAVMGNPKVKAHGKKVLHSFGEGVHHLDN-----LKGTFAALSELHCDKLHVDPENFRL
Human alpha ----HGSAQVKGHGKKVADALTNAVAHVDD-----MPNALSALSDLHAHKLRVDPVNFKL
Horse alpha ----HGSAQVKAHGKKVGDALTLAVGHLDD-----LPGALSNLSDLHAHKLRVDPVNFKL
Whale myoglobin EAEMKASEDLKKHGVTVLTALGAILKKKGH-----HEAELKPLAQSHATKHKIPIKYLEF
Lamprey globin ADQLKKSADVRWHAERIINAVNDAVASMDDT--EKMSMKLRDLSGKHAKSFQVDPQYFKV
Lupin globin VP--QNNPELQAHAGKVFKLVYEAAIQLQVTGVVVTDATLKNLGSVHVSKGVAD-AHFPV

. .:: *. : . : *. * . : .

Human beta LGNVLVCVLAHHFGKEFTPPVQAAYQKVVAGVANALAHKYH------
Horse beta LGNVLVVVLARHFGKDFTPELQASYQKVVAGVANALAHKYH------
Human alpha LSHCLLVTLAAHLPAEFTPAVHASLDKFLASVSTVLTSKYR------
Horse alpha LSHCLLSTLAVHLPNDFTPAVHASLDKFLSSVSTVLTSKYR------
Whale myoglobin ISEAIIHVLHSRHPGDFGADAQGAMNKALELFRKDIAAKYKELGYQG
Lamprey globin LAAVIADTVAAG---D------AGFEKLMSMICILLRSAY-------
Lupin globin VKEAILKTIKEVVGAKWSEELNSAWTIAYDELAIVIKKEMNDAA---

: : .: . .. . :

Fig. 3.1 Multiple alignment of seven amino acid sequences. Identical amino acid positions are
marked with asterisks (*) and biochemically conserved positions are marked with colons and
periods (less conserved). The lupin sequence is a leghemoglobin and the lamprey sequence
is a cyanohemoglobin. The whale sequence is from the sperm whale. The approximate
positions of the alpha helices are typed in italics and bold font. The positions of two
important histidine residues are underscored, and are responsible for binding the prosthetic
heme and oxygen.

in the simple diagram in Fig. 3.2. It is not clear which example of a repeat unit
should line up between the different members of the family. If there are large-scale
repeats such as with duplications of entire protein domains, then the problem
can be partly solved by excising the domains or repeat units and conducting a
phylogenetic analysis of the repeats. This is only a partial solution because a single
domain in one ancestral protein can give rise to two equidistant repeat units in
one descendant protein and three in another; therefore, it will not be obvious how
the repeat units should line up with one another. With small-grain repeats, such as
those involving single nucleotides or with microsatellite sequences, the problem is
even worse.

As shown in Fig. 3.2b, it is not obvious in the highlighted box if one alignment
of the sequences is better than any other, except maybe cosmetically. One can only
conclude that there are some repeated C residues. Fortunately, these alignment
details often make no difference in a phylogenetic context and, in some cases, these
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(a) 

 
 
 
 
 
 
 
 
 
 

(b) 
accgtacc--gtaccgt
accgtaccccgtaccgt
accgtac---gtaccgt
accgtacac-gtaccgt
****** *******

Fig. 3.2 (a) A simple diagram showing the distribution of a repeated domain (marked with a rectan-
gle) in a set of sequences. When there are different numbers of repeats in the sequences, it
can be difficult to know exactly how to arrange the alignment. Some domains will be equally
similar to several domains in other sequences. (b) A simple example of some nucleotide
sequences in which the central boxed alignment is completely ambiguous.

regions are simply ignored in phylogenetic inference. All computer programs will
experience difficulties to unambiguously disentangle these repeats and, frequently,
there is no ideal alignment. These small-scale repeats are especially abundant in
some nucleotide sequences, where they can accumulate in particular positions due
to mistakes during DNA replication. They tend to be localized to non-protein
coding regions or to hypervariable regions; these will be almost impossible to
align unambiguously and should be treated with caution. In amino acid sequences,
such localized repeats of residues are unusual, whereas large-scale repeats of entire
protein domains are very common.

3.3 The problem of substitutions

If the sequences in a data set accumulate few substitutions, they will remain similar
and they will be relatively easy to align. The many columns of unchanged residues
should make the alignment straightforward. In these cases, both manual and com-
puterized alignment will be clear and unambiguous; in reality, sequences can and
do change considerably.

For two amino acid sequences, it becomes increasingly difficult to find a good
alignment once the sequence identity drops below approximately 25% (see also
Chapter 9). Sequence identity, a commonly used and simple measure of sequence
similarity, is the number of identical residues in an alignment divided by the
total number of aligned positions, excluding any positions with a gap. Of course,
a nonsensical alignment with a gap every two or three residues, for example,
can result in a misleading measure of sequence similarity. In general, however,
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VHLTPEEKSAVTALWGKVN--VDEVGGEALGRLLVVYPWTQRFFESFGDLSTPDAVMGNP
V-LSPADKTNVKAAWGKVGAHAGEYGAEALERMFLSFPTTKTYFPHF-DLS-----HGSA
* * * * * * **** * * *** * * * * * *** *

KVKAHGKKVLGAFSDGLAHLDNLKGTFATLSELHCDKLHVDPENFRLLGNVLVCVLAHHF
QVKGHGKKVADALTNAVAHVDDMPNALSALSDLHAHKLRVDPVNFKLLSHCLLVTLAAHL
** ***** * ** * ** ** ** *** ** ** * ** *

GKEFTPPVQAAYQKVVAGVANALAHKYH
PAEFTPAVHASLDKFLASVSTVLTSKYR
**** * * * * * * **

Fig. 3.3 An alignment of the amino acid sequences of human alpha globin (below) and human beta
globin (above). The boxed pairs of residues are all between pairs of similar amino acids
(i.e. biochemically similar side chains). The most conserved pairs are S and T (small polar);
F and Y (aromatic); D and E (acidic, negatively charged); any two of H, K, and R (positively
charged); and any two of F, I, L, M, or V (hydrophobic). Many of the other unmarked pairs
also represent some conservation of biochemical property.

the measure is rather robust. Consider any pair of aligned homologous protein
sequences with some positions where one or both residues have changed during
evolution. When examining the nature of these changes, two patterns emerge
(e.g. Fig. 3.3). First, the identities and differences are not evenly distributed along
the sequence. Particular blocks of alignment with between 5 and 20 residues will
have more identities and similar amino acids (i.e. biochemically similar; discussed
in the next section) than elsewhere. These blocks will typically correspond to the
conserved secondary-structure elements of α-helices and β-strands in the proteins,
and are more functionally constrained than the connecting loops of irregular
structure. The same pattern is observed when examining the gap locations in the
sequences. This pattern of blocks is more obvious in multiple alignments of protein
sequences (see Fig. 3.1). One benefit of this block-like similarity is that there will be
regions of alignment which are clear and unambiguous and which most computer
programs can find easily, even between distantly related sequences. However, it also
means that there will be sequence regions that are more difficult to align and, if the
sequences are sufficiently dissimilar, impossible to align unambiguously.

The second observed pattern is that most of the pairs of aligned, but non-identical
residues, are biochemically similar (i.e. their side chains are similar). Similar amino
acids such as leucine and isoleucine or serine and threonine tend to replace each
other more often than dissimilar ones (see Fig. 3.3). This conservation of biochem-
ical character is especially true in the conserved secondary-structure regions and
at important sites such as active sites or ligand-binding domains. By far the most
important biochemical property to be conserved is polarity/hydrophobicity. The
amino acid size also matters but the exact conservation pattern will depend on the
specific role of the amino acid in the protein. These patterns of conservation can
significantly aid sequence alignment.
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To carry out an automatic alignment, it is necessary to quantify biochemical
similarity. Previous attempts focused on chemical properties and/or the genetic
code; however, for both database searching and multiple alignment, the most
popular amino acid scoring schemes are based on empirical studies of aligned
proteins. Until the early 1990s, the most powerful method resulted from the work
of Margaret Dayhoff and colleagues, who produced the famous PAM series of
weight matrices (Dayhoff et al., 1978) (see also Chapter 9). Protein substitution
matrices are 20 × 20 tables that provide scores for all possible pairs of aligned
amino acids. The higher the score, the more weight is attached to the pair of
aligned residues. The PAM matrices were derived from the original empirical data
using a sophisticated evolutionary model, which allowed for the use of different
scoring schemes depending on how similar the sequences were. Although this was
a powerful capability, most biologists used the default table offered by whatever
software they were using. Currently, the PAM matrices have largely been superseded
by the BLOSUM matrices of Jorja and Steven Henikoff (1992), which are also
available as a series, depending on the similarity of the sequences to be aligned.
The most commonly used BLOSUM62 matrix, shown in Fig. 3.4, illustrates how
different pairs of identical residues get different scores. Less weight is assigned to
residues which change readily during evolution, such as alanine or serine, and more
weight is assigned to those that change less frequently, such as tryptophan. The
remaining scores are either positive or negative, depending on whether a particular
pair of residues are more or less likely to be observed in an alignment.

Given the table in Fig. 3.4, the alignment problem is finding the arrangement of
amino acids resulting in the highest score summed over all positions. This is the
basis of almost all commonly used alignment computer programs. One notable
exception is software based on the so-called hidden Markov models (HMMs),
which use probabilities rather than scores; however, these methods use a concept
related to amino acid similarity.

For nucleotide sequences, it is much harder to distinguish conservative from
non-conservative substitutions. In addition, two random sequences of equal base
compositions will be 25% identical. As a consequence, it may be difficult to make a
sensible alignment if the sequences have diverged significantly, especially if the
nucleotide compositions are biased and/or if there are many repeats. This is
one reason why, if there is a choice, it is important to align protein coding sequences
at the amino acid level.

3.4 The problem of gaps

Insertions and deletions also accumulate as sequences diverge from each other. In
proteins, these are concentrated between the main secondary structure elements,
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A 4
R –1 5
N -2 0 6
D -2 -2 1 6
C 0 -3 -3 -3 9
Q -1 1 0 0 -3 5
E -1 0 0 2 -4 2 5
G 0 -2 0 -1 -3 -2 -2 6
H -2 0 1 -1 -3 0 0 -2 8
I -1 -3 -3 -3 -1 -3 -3 -4 -3 4
L -1 -2 -3 -4 -1 -2 -3 -4 -3 2 4
K -1 2 0 -1 -3 1 1 -2 -1 -3 -2 5
M -1 -1 -2 -3 -1 0 -2 -3 -2 1 2 -1 5
F -2 -3 -3 -3 -2 -3 -3 -3 -1 0 0 -3 0 6
P -1 -2 -2 -1 -3 -1 -1 -2 -2 -3 -3 -1 -2 -4 7
S 1 -1 1 0 -1 0 0 0 -1 -2 -2 0 -1 -2 -1 4
T 0 -1 0 -1 -1 -1 -1 -2 -2 -1 -1 -1 -1 -2 -1 1 5
W -3 -3 -4 -4 -2 -2 -3 -2 -2 -3 -2 -3 -1 1 -4 -3 -2 11
Y -2 -2 -2 -3 -2 -1 -2 -3 2 -1 -1 -2 -1 3 -3 -2 -2 2 7
V 0 -3 -3 -3 -1 -2 -2 -3 -3 3 1 -2 1 -1 -2 -2 0 -3 -1 4

A R N D C Q E G H I L K M F P S T W Y V

Fig. 3.4 The BLOSUM62 matrix. Similarity scores for all 20 × 20 possible pairs of amino acids,
including identical pairs (the diagonal elements). Negative numbers represent pairs that
are not commonly observed in real alignments; positive numbers represent commonly
found pairs (shaded). These scores allow us to quantify the similarity of sequences in an
alignment, when combined with gap scores (i.e. gap penalties).

just as for substitutions. Normally, no distinction is made between insertions and
deletions, which are sometimes collectively referred to as indels. In alignments, they
show up as gaps inserted in sequences in order to maximize an alignment score.

If there were no indels, the optimal alignment for sequences could be found by
simply sliding one over the other. To choose the alignment with the highest score,
the weight matrix scores are counted for each pair of aligned residues. With the
presence of indels, a proper alignment algorithm is required to find the arrangement
of gaps that maximizes the score. This is usually accomplished using a technique
called dynamic programming (Needleman & Wunsch, 1970; Gotoh, 1982), which
is an efficient method for finding the best alignment and its score. However, there
is an additional complication: if gaps of any size can be placed at any position,
it is possible to generate alignments with more gaps than residues. To prevent
excessive use of gaps, indels are usually penalized (a penalty is subtracted from the
alignment score) using so-called gap penalties (GPs). The most common formula
for calculating GPs follows.

GP = g + e(l − 1) (3.1)

where l is the length of the gap, g is a gap opening penalty (charged once per gap)
and e is a gap-extension penalty (charged once per hyphen in a gap). These penalties
are often referred to as affine gap penalties. The formula is quite flexible in that
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VHLTPEEKSAVTALWGKVNVDEVGGEAL...
V-----------------NEEEVGGEAL...

Fig. 3.5 A simple example to illustrate the problem of end gaps. The second sequence is missing a
section from its N-terminus, and the end V aligns with the N-terminal V of the first sequence.
This is clearly a nonsensical alignment, but it gets exactly the same score as the one with
the V moved across to join the rest of the second sequence – unless end gaps are free
(there is no GP for end gaps).

it allows the number and the lengths of gaps to be controlled separately by setting
different values for g and e. However, there is no particular mathematical, statistical
or biological justification for this formula. It is widely used because it works often
well and it is straightforward to implement it in computer programs. In practice,
the values of g and e are chosen arbitrarily, and there is no reason to believe that
gaps simply evolve as the formula suggests. Significantly, the alignment with the
highest alignment score may or may not be the correct alignment in a biological
sense. Finally, it is common to make end gaps free (un-penalized), which takes into
account that, for various biological and experimental reasons, many sequences are
missing sections from the ends. Not making end gaps free risks getting nonsensical
alignments, such as the one shown in Fig. 3.5.

3.5 Pairwise sequence alignment

3.5.1 Dot-matrix sequence comparison
Probably the oldest way to compare two nucleotide or amino acid sequences is
a dot matrix representation or dot plot. In a dot plot two sequences are compared
visually by creating a matrix where the columns are the character positions in
sequence 1 and the rows are the character positions in sequence 2 (see Fig. 3.6).
A dot is placed in location (i, j) if the ith character of sequence 1 matches the
jth character of sequence 2. For nucleotide sequences, long protein sequences, or
very divergent proteins, better resolution can be obtained by employing a sliding
window approach to compare blocks of N residues (usually 5 to 20 amino acids or
nucleotides). Two blocks are said to match if a mismatch level is not exceeded. For
example, the user can look for DNA or amino acid stretches of length 10 (window
size = 10) with the mismatch limit equal to 3, which means that a dot will be placed
in the graph only if at least 7 out of 10 residues in the two 10-nucleotide stretches
compared have identical residues. This procedure filters a considerable amount of
noise that can be attributed to random matches of single residues. A high similarity
region will show as a diagonal in the dot plot. This method can be used to explore
similarity quickly in large genomic fragments, and thus evaluate homology among
sequences, and can reveal features like internal repetitive elements when proteins
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G G G C A A G T A C A T C A G G C C A TA AT G
G
G
G
A
C
A
A
A
T
G
G
T
A
C
A
T
C
A
A
G
C
C
A

GGG-CAAATGGTACATCAGGCCATA

GGGACAAATGGTACATCAAGCCA--
* * **

(a)

(b)

Sequence 1

Se
qu

en
ce

 2

Fig. 3.6 (a). DNA dot plot representation with stringency 1 and window size 1 (see text). The
nucleotides at each site of Sequence 1 and Sequence 2 are reported on the x (5′ → 3′ from
left to right) and y axes (5′ → 3′ from top to bottom), respectively. Each nucleotide site of
a sequence is compared with another sequence, and a dot is placed in the graph in case of
identical residues. The path drawn by the diagonal line represents regions where the two
sequences are identical; the vertical arrow indicates a deletion in Sequence 1 or an insertion
in Sequence 2. (b) Sequence alignment resulting from following the path indicated in the
dot plot representation.

are compared to themselves. However, their use has become somewhat obselete
and we mainly discuss the method for historical and educational purposes.

3.5.2 Dynamic programming
For two sequences, dynamic programming can find the best alignment by scoring
all possible pairs of aligned residues and penalizing gaps. This is a relatively rapid
procedure on modern computers, requiring time and memory proportional to
the product of the sequence lengths (N). This is usually referred to as an “N2

algorithm” or as having complexity O(N2). In practice, unless the two sequences
are enormous, pairwise alignment through dynamic programming can be achieved
in a matter of seconds. Dynamic programming is based on Bellman’s principle of
optimality, which states that any subsolution of an optimal solution is itself an
optimal solution. In Box 3.1, we use an amino acid example to illustrate how this
principle can be used to find the best pairwise alignment.



76 Des Higgins and Philippe Lemey

Box 3.1 Dynamic programming

The dynamic programming algorithm guarantees us to find the optimal scoring alignment
of two sequences without enumerating all possible solutions. The solution to the problem
can be considered as the optimal scoring path in a matrix. The scoring system in our
example is constituted by the BLOSUM62 (see Fig. 3.4) substitution matrix and a simple
linear gap penalty g taking the value of −8. We will introduce affine gap penalties in a
later example. A matrix for sequence X (GRQTAGL) and sequence Y (GTAYDL) filled
with the relevant BLOSUM62 substitution scores and gap penalties is shown below:

G 

Sequence X 

Se
qu

en
ce

 Y
 -8 

-8 

6 

0 

1 

1 

i 
j 

2 

2 

3 

3 

4 

4 
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5 

6 

6 

7 

7 
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-2 

-2 

-2 

-2 

-2 -2 -2 

-2 

-2 

-2 

-2 

-1 -1 

-1 

-2 

0 

0 
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4 

5 

-4 

-4 

-4 

6 

-3 -3 

-1 

-1 -1 

-1 

-1 

-1 

-1 

-1 

-1 

-4 

-8 -8 -8 

-8 

-8 

-8 

-8 
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-8 

-8 

-8 

G 

* 
* 

R Q T 
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A 
Y 

G L 

L 
D 

To allow for end gaps, a boundary condition is imposed through the use of a complete
gap column (i = 1, denoted by ∗) and a complete gap row (j = 1). In a first step of
the algorithm, we need to find optimal alignments for smaller subsequences. This can
be achieved by finding the best scoring subpath for each element (i, j) in the matrix
(F). For each element, we need to consider three options: a substitution event (Xi, Yi)
moving from (i−1, j−1) to (i, j), an insertion in X (or deletion in Y) moving from (i−1, j)
to (i, j), and a deletion in X (or insertion in Y) moving from (i, j−1) to (i, j). Hence, the
best subpath up to (i, j), will be determined by the score:

F (i, j ) = max






F (i − 1, j − 1) + s (Xi , Yi ),
F (i − 1, j ) − g ,

F (i, j − 1) − g
(3.2)

where s(Xi, Yi) is the score defined by the BLOSUM62 substitution matrix. We can apply
this equation to fill the matrix recursively: column-wise from top left to bottom right.
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Importantly, we also will use a pointer to keep track of the movement in the matrix that
resulted in the best score F(i, j). For the first gap column (i = 1), only sequential gap
events can be considered, reducing (3.2) to F (i, j ) = F (i, j − 1) − g . The same is true
for the gap row (j = 1). The first element for which (1.2) needs to be fully evaluated is
(i = 2, j = 2). For this element the best score is 6 as a result of:

F (2, 2) = max






F (1,1) + s (X2,Y2) = 6,

F (1, 2) − 8 = −16,

F (2, 1) − 8 = −16

In this case, a pointer indicates a substitution event (Xi, Yi) moving from (i−1, j−1) to
(i, j). We continue by finding the best score for element (i = 2, j = 3), given by:

F (2, 3) = max






F (1, 2) + s (X2, Y3) = −10,

F (1, 3) − 8 = −16,

F (2, 2) − 8 = −2

In which case a pointer is kept to indicate a deletion in X (or insertion in Y) moving from
(i, j−1) to (i, j). Repeating this procedure results in the matrix:

G 

Sequence X 
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-8 
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-3 
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D 

Note that for some elements, e.g. (i = 4, j = 3) two pointers are kept indicating paths
that resulted in an equal score. Now that the matrix has been completed, we need to
identify the best alignment based on all the pointers we have kept (represented by the
arrows). We start from the score in the final element and follow the path indicated by
the arrows, a procedure known as traceback. It is exactly here that we rely on Bellman’s
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Box 3.1 (cont.)

optimality principle: if the final element reports the score for the best path, then the
sub-solution leading to this element is also lying on the optimal path. So, if we are able
to identify the optimal subpath leading to this element, than the preceding element is
guaranteed to lie on the optimal path allowing us to continue the traceback procedure
from this sub-solution. If two paths can be followed (for example, from (i = 4, j = 3)
to (i = 3, j = 3) or to (i = 3, j = 2)), than an arbitrary choice must be made (indicated
by the dashed circles). Each step in the traceback procedure can be associated with the
assembly of two symbols to construct the alignment: adding symbol Xi and Yj if the step
was to (i−1, j−1), Xi and a gap if the step was to (i−1, j), or a gap and Yj if the step was to
(i, j−1). Hence, the alignment is constructed from right to left. Depending on the choice
made at (i = 4, j = 3) in our example, this assembly results in the alignment:

GRQTAGL or GRQTAGL

GT-AYDL G-TAYDL

It is not surprising that these alignments have an equal score since both proposed amino
acid substitutions (R↔T) and (Q↔T) are equally penalized by BLOSUM62 (Fig. 3.4).

Since gaps are often observed as blocks in sequence alignments, a simple linear gap
penalty will generally be biologically unreasonable in real-world data. Therefore, affine
gap penalties (see 3.1) have been the preferred choice for penalizing gaps in many
algorithms. Here, we will extend our example using a gap-opening penalty of −8 and a
gap extension penalty of −2. In this case, the matrix recursively completed with scores
for the optimal subpath to each element is given by:

G 
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Note that the use of affine gap penalties significantly reduces the cost for sequential
gaps (e.g. for column i = 1). Affine gap penalties introduce an additional complexity of
having to keep track of multiple values. To evaluate the cost for a subpath that involves
inserting a gap, we need to consider that the previous step may also have required the
insertion of a gap. In this case, a gap extension needs to be penalized; in the other case,
we need to penalize a gap opening. Interestingly, this scoring scheme results in a different
optimal path, with which only a single alignment can be associated:

GRQTA-GL

G--TAYDL

This example illustrates that different scoring schemes, for which the gap penalties values
are usually chosen arbitrarily, can result in different alignments. Therefore, it is generally
recommended to explore how changing default values in alignment programs influences
the quality of the sequence alignments.

3.6 Multiple alignment algorithms

The dynamic programming approach described in Box 3.1 can easily be generalized
to more than two sequences. In this case, the alignment maximizing the similarity
of the sequences in each column (using an amino acid weight matrix as usual)
is found while allowing some minimal number and lengths of gaps. The task is
most commonly expressed as finding the alignment that gives the best score for the
following formula, called the weighted sum of pairs or WSP objective function:

∑
i

∑
j

Wi j Di j (3.3)

For any multiple alignment, a score between each pair of sequences (Dij) is calcu-
lated. Then, the WSP function is simply the sum of all of these scores, one for each
possible pair of sequences. There is an extra weight term Wij for each pair, that is,
by default, always equal to one, but enables weighting some pairs more than others.
This can be extremely useful to give more weight to pairs that are more reliable
or more important than others. Alternatively, it can be used to give less weight to
sequences with many close relatives because these are overrepresented in the data
set. Although the weighting can be inspired by evolutionary relationships, the WSP
fails to fully exploit phylogeny and does not incorporate an evolutionary model
(Edgar & Batzoglou, 2006). Dynamic programming can be used to find a multiple
alignment that gives the best possible score for the WSP function. Unfortunately,
the time and memory required grows exponentially with the number of sequences
as the complexity is O(NM), where M is the number of sequences and N is the
sequence length. This quickly becomes impossible to compute for more than four
sequences of even modest lengths.
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One elegant solution to the computational complexity came from the Msa pro-
gram of Lipman et al. (1989). It used a so-called branch-and-bound technique to
eliminate many unnecessary calculations making it possible to compute the WSP
function for five to eight sequences. The precise number of sequences depended on
the length and similarity; the more similar the sequences, the faster the calculation
and the larger the number of sequences that could be aligned. Although this is an
important program, its use is still limited by the small number of sequences that
can be managed. In tests with BaliBase (see below for more information on testing
multiple alignment methods), this program performs extremely well although it is
not able to handle all test cases (any with more than eight sequences). The FastMSA
program, a highly optimized version of Msa, is faster and uses less memory, but it
is still limited to small data sets.

In the following paragraphs, we discuss several heuristics or approximate alterna-
tives for multiple sequence alignment and some of their most popular implementa-
tions. A comprehensive listing of multiple sequence programs and their availability
can be found in Table 3.1. An updated version of this table with updated links to
download pages and servers running web-based applications will be maintained
on the website accompanying this book (www.thephylogenetichandbook.org).

3.6.1 Progressive alignment
Multiple alignments are the necessary prerequisite for phylogenetic analysis. Con-
versely, if the phylogenetic relationships in a set of sequences were known, this
information could be useful to generate an alignment. Indeed, this mutual rela-
tionship was the basis of an early multiple alignment method (Sankoff, 1985)
which simultaneously generated the tree and alignment; unfortunately, the par-
ticular method is too complex for routine use. One very simple shortcut is to
make a quick and approximate tree of the sequences and use this to make a mul-
tiple alignment, an approach first suggested by Hogeweg and Hesper (1984). The
method is heuristic in a mathematical sense insofar as it makes no guarantees to
produce an alignment with the best score according to the optimality criterion.
Nonetheless, this method is extremely important because it is the way the vast
bulk of automatic alignments are generated. As judged by test cases, it performs
very well, although not quite as well as those methods that use the WSP objective
function. This lack of sensitivity is only visible with the most difficult test cases;
for similar sequences, progressive alignment is perfectly adequate. The sheer speed
of the method, however, and its great simplicity, make it extremely attractive for
routine work.

A phylogenetic tree showing the relatedness of the sequences in Fig. 3.1, is
shown in Fig. 3.7. A similar tree can be generated quickly by making all possible
pairwise alignments between all the sequences and calculating the observed distance
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Horse beta 
 
                               Human beta 
 
                              Horse alpha 
 

Human alpha 
 
                             Whale myoglobin 

Lamprey globin 
 
                               Lupin globin 

Fig. 3.7 A rooted tree showing the possible phylogenetic relationships between the seven globin
sequences in Fig. 3.1. Branch lengths are drawn to scale.

Sequences

Pairwise alignment

Sequence–group alignment

Group–group alignment

Final multiple alignment

Fig. 3.8 Schematic representation of progressive alignment. This procedure begins with the align-
ing the two most closely related sequences (pairwise alignment) and subsequently adds
the next closest sequence or sequence group to this initial pair (sequence–group or group–
group alignment). This process continues in an iterative fashion along the guide tree, adjust-
ing the positioning of indels in all grouped sequences.

(proportion of residues that differ between the two sequences) in each case. Such
distances are used to make the tree with one of the widely available distance methods
such as the neighbor-joining (NJ) method of Saitou and Nei (1987) (see Chapter 5).
NJ trees, for example, can be calculated quickly for as many as a few hundred
sequences. Next, the alignment is gradually built up by following the branching
order in the tree (Fig. 3.8). The two closest sequences are aligned first using dynamic
programming with GPs and a weight matrix (Fig. 3.8). For further alignment, the
two sequences are treated as one, such that any gaps created between the two cannot
be moved. Again, the two closest remaining sequences or pre-aligned groups of
sequences are aligned to each other (Fig. 3.8). Two unaligned sequences or two sub-
alignments can be aligned or a sequence can added to a sub-alignment, depending
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on which is more similar. The process is repeated until all the sequences are aligned.
Once the initial tree is generated, the multiple alignment can be carried out with
only N-1 separate alignments for N sequences. This process is fast enough to align
many hundreds of sequences.

Clustal

The most commonly used software for progressive alignment is ClustalW
(Thompson et al., 1994) and ClustalX (Thompson et al., 1997). These programs
are freely available as source code and/or executables for most computer platforms
(Table 3.1). They can also be run using servers on the Internet at a number
of locations. These programs are identical to each other in terms of alignment
method but offer either a simple text-based interface (ClustalW) suitable for high-
throughput tasks or a graphical interface (ClustalX). In the discussion that follows,
we will refer only to ClustalW but all of it applies equally to ClustalX. ClustalW
will take a set of input sequences and carry out the entire progressive alignment
procedure automatically. The sequences are aligned in pairs in order to generate
a distance matrix that can be used to make a simple initial tree of the sequences.
This guide tree is stored in a file and is generated using the Neighbor-Joining
method of Saitou and Nei (1987). This produces an unrooted tree (see Chapter 1),
which is used to guide the multiple alignment. Finally, the multiple alignment is
carried out using the progressive approach, as described above.

ClustalW has specific features which help it make more accurate alignments.
First, sequences are down-weighted according to how closely related they are to
other sequences (as judged by the guide tree). This is useful because it prevents large
groups of similar sequences from dominating an alignment. Secondly, the weight
matrix used for protein alignments varies, depending on how closely related the next
two sequences or sets of sequences are. One weight matrix can be used for closely
related sequences that gives high scores to identities and low scores otherwise. For
very distantly related sequences, the reverse is true; it is necessary to give high scores
to conservative amino acid matches and lower scores to identities. ClustalW uses a
series of four matrices chosen from either the BLOSUM, or PAM series (Henikoff &
Henikoff, 1992 and Dayhoff et al., 1978, respectively). During alignment, the pro-
gram attempts to vary GPs in a sequence- and position-specific manner, which
helps to align sequences of different lengths and different similarities. Position-
specific GPs are used in an attempt to concentrate gaps in the loops between the
secondary structure elements, which can be set either manually using a mask or
automatically. In the latter case, GPs are lowered in runs of hydrophilic residues
(likely loops) or at positions where there are already many gaps. They are also
lowered near some residues, such as Glycine, which are known to be common near
gaps from empirical analysis (Pascarella & Argos, 1992). GPs are raised adjacent
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to existing gaps and near certain residues. These and other parameters can be set
by the user before each alignment. Although ClustalW is still the most popular
alignment tool, several more recent methods have now been shown to perform
better in terms of accuracy and/or speed.

3.6.2 Consistency-based scoring
Progressive alignment is fast and simple, but it does have one obvious drawback: a
local-minimum problem. Any alignment errors (i.e. misaligned residues or whole
domains) that occur during the early alignment steps cannot be corrected later as
more data are added. This may be due to an incorrect tree topology in the guide
tree, but it is more likely due to simple errors in the early alignments. The latter
occurs when the alignment with the best score is not the best one biologically
or not the best if one considers all of the sequences in a data set. An effective
way to overcome this problem is to use “consistency-based” scoring (Kececioglu,
1992), which is based on the WSP function and has been successfully used as an
improvement over progressive alignment (Notredame et al., 1998). Consistency-
based alignment techniques use intermediate sequence information to improve
the quality of pairwise comparisons and search for the multiple sequence align-
ment that maximizes the agreement with a set of pairwise alignments computed
for the input sequences (such a procedure acknowledges that the pairwise align-
ments A–B and B–C may imply an A–C alignment that is different from the
alignment directly computed for A and C) (Do et al., 2004; Edgar & Batzoglou,
2006).

T-Coffee

Tree-based consistency objective function for alignment evaluation (T-Coffee)
is the prototypical consistency-based alignment method (Notredame et al.,
2000). Although T-Coffee is relatively slow, it generally results in more accu-
rate alignments than ClustalW, Prrp (Gotoh, 1996), and Dialign (Morgenstern
et al., 1996; Morgenstern, 2004) when tested on BaliBase (see below). Indeed,
this increase in accuracy is most pronounced for difficult test cases and is found
across all of the BaliBase test sets. The method is based on finding the multiple
alignment that is most consistent with a set of pairwise alignments between the
sequences. These pairwise alignments can be derived from a mixture of sources such
as different alignment programs or from different types of data such as structure
superpositions and sequence alignments. These are processed to find those aligned
pairs of residues in the initial data set which are most consistent across different
alignments. This information is used to compile data on which residues are most
likely to align in which sequences. Finally, this information is used to build up
the multiple alignment using progressive alignment, a fast and simple procedure
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that requires no other parameters (GPs or weight matrices). The main disadvan-
tage of T-Coffee over ClustalW is that the former is much more computationally
demanding and cannot handle large alignment problems as can the latter.

3.6.3 Iterative refinement methods
The pioneering work on alignment algorithms by Gotoh eventually resulted in
the Prrn and Prrp programs (now unified to “ordinary” or “serial” Prrn) (Gotoh
1995, 1996 and 1999). Prrn uses an iterative scheme to gradually work toward the
optimal alignment. At each iteration cycle, the sequences are randomly split into
two groups. Within each group, the sequences are kept in fixed alignment, and
the two groups are then aligned to each other using dynamic programming. This
cycle is repeated until the score converges. The alignments produced by Prrn are
excellent, as judged by performance using BaliBase and other test cases (Notredame
et al., 1998; Thompson et al., 1999). The program is, however, relatively slow with
more than 20 sequences and not widely adopted.

Recently, more efficient implementations of iterative refinement methods have
been developed under the name of Mafft and Muscle (Katoh et al., 2002, 2005;
Edgar, 2004a,b). These have the same basic strategy of building a progressive
alignment, to which horizontal refinement subsequently is applied. Mafft applies
the “fast Fourier Transform” to rapidly detect homologous regions and also uses
an improved scoring system. Muscle allows fast distance estimation using “k-
mer counting,” progressive alignment using a novel profile function, and refine-
ment using “tree-dependent restricted partitioning.” Both programs are fine-tuned
towards high-throughput applications, offering significant improvements in scal-
ability while still performing relatively accurately. It should be noted that recent
versions of Mafft (v.5 or higher) implement variants of the algorithm with an
objective function combining the WSP score and Coffee-like score, which could be
classified under consistency-based alignment.

3.6.4 Genetic algorithms
The Saga program (Notredame & Higgins, 1996) is based on the WSP objective
function but uses a genetic algorithm instead of dynamic programming to find
the best alignment. This stochastic optimization technique grows a population of
alignments and evolves it over time using a process of selection and crossing to find
the best alignment. Comparisons with the performance of Msa, which implements
the branch-and-bound technique, suggest that Saga can find the optimal alignment
in terms of theWSP function. The advantage of Saga, however, is its ability to deliver
good alignments for more than eight sequences; the disadvantage is that it is still
relatively slow, perhaps taking many hours to compute to a good alignment for
20 or 30 sequences. The program must also be run several times because the
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stochastic nature of the algorithm does not guarantee the same results for different
runs. Despite these reservations, Saga has proven useful because it allows the testing
of alternative WSP scoring functions.

3.6.5 Hidden Markov models
An interesting approach to alignment is the so-called hidden Markov models or
HMMs, which are based on probabilities of residue substitution and gap insertion
and deletion (Krogh et al., 1994). HMMs have been shown to be extremely useful
in a wide variety of situations in computational molecular biology, such as locating
introns and exons or predicting promoters in DNA sequences. HMMs are also very
useful for summarizing the diversity of information in an existing alignment of
sequences and predicting whether new sequences belong to the family (e.g. Eddy,
1998; Bateman et al., 2000). Packages are available that simultaneously generate
such an HMM and find the alignment from unaligned sequences. These methods
used to be inaccurate (e.g. see results in Notredame et al., 1998); however, some
progress has been made and the SAM method (Hughey & Krogh, 1996) is now
roughly comparable to ClustalW in accuracy, although not as easy or as fast to
use.

3.6.6 Other algorithms
The Divide and Conquer, Dca (Stoye et al., 1997), program also computes align-
ments according to the WSP scoring function. The algorithm finds sections of
alignment, which when joined together head to tail, will give the best alignment.
Each section is found using the Msa program and so, ultimately, it is limited in the
number of sequences it can handle, even if more than Msa.

Consistency-based progressive alignment methodology has been combined with
probabilistic HMMs to account for suboptimal alignments (Do et al., 2004).
The ProbCons program implements this approach called posterior probability-
based scoring (Durbin et al., 1998), with additional features such as unsupervised
expectation-maximization parameter training. This makes the approach highly
accurate, but unfortunately, also computationally expensive, limiting practical
application to data sets of less than 100 sequences. More complex pairwise align-
ment HMMs that incorporate local structural information and better estimation
of HMM parameters have recently been implemented in Mummals (Pei & Grishin,
2006).

All methods described above try to globally align sequences, which “forces” the
alignment to span the entire length of all query sequences. Recently developed
methods, like Align-M (Van Walle et al., 2004), Dialign (Morgenstern et al., 1998;
Morgenstern, 1999; Subramanian et al., 2005), Poa (Lee et al., 2002; Grasso &
Lee, 2004) and Satchmo (Edgar & Sjölander, 2003), have relaxed the constraint
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of global alignability to make possible the alignment of sequences highly variable
in length or sequences with different domain structure. The Dialign method of
Morgenstern (1999) is based on finding sections of local multiple alignment in a
set of sequences; that is, sections similar across all sequences, but relatively short.
Dialign will therefore be useful if the similarity is localized to isolated domains. In
practice, the algorithm performed well in two of the BaliBase test sets: those with
long insertions and deletions; otherwise, ClustalW easily outperforms Dialign.
Although Dialign allows unalignable regions, the alignable domains must still
appear in the same order in the sequences being compared. To overcome this
problem, ProDA has recently been developed to identify and align all homologous
regions appearing, not necessarily colinear, in a set of sequences (Phuong et al.,
2006).

3.7 Testing multiple alignment methods

The most common way to test an alignment method is by assessing its performance
on test cases. Exaggerated claims have been made about how effective some methods
are or why others should be avoided. The user-friendliness of the software and
its availability are important secondary considerations, but ultimately, it is the
quality of the alignments that matters most. In the past, many new alignment
programs have been shown to perform better than older programs, using one or
two carefully chosen test cases. The superiority of the new method is then often
verbally described by authors who selected particular parameter values (i.e. GPs
and weight matrix) that favor the performance of their program. Of course, authors
do not choose test cases for which their programs perform badly and, to be fair,
some underappreciated programs perform well on some test cases and are still
potentially useful.

One solution is to use benchmark data sets, generated by experts, with exten-
sive reference to secondary and tertiary structural information. For structural
RNA sequences, the huge alignments of ribosomal RNA sequences can be used as
tests; these comparisons, however, are difficult and not necessarily generalizable.
For proteins, an excellent collection of test cases is called BaliBase (Thompson
et al., 1999), to which we have referred to in the description of some programs.
BaliBase is a collection of 141 alignments representing five different types of
alignment situations: (1) equidistant (small sets of phylogenetically equidistant
sequences); (2) orphan (as for Type 1 but with one distant member of the family);
(3) two families (two sets of related sequences, distantly related to each other);
(4) long insertions (one or more sequences have a long insertion); (5) long dele-
tions. These test cases are made from sets of sequences for which there is extensive
tertiary-structure information. The sequences and structures were carefully com-
pared and multiple alignments were produced by manual editing.
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The use of these test cases involves several assumptions. Although contradictory
scenarios can be envisaged, the first assumption is that an alignment maximizing
structural similarity is somehow “correct.” A more serious assumption is that the
reference alignment has been made correctly. Although parts of alignments will be
difficult to judge, even with tertiary information, this can be largely circumvented
by selecting and focusing only on those regions of core alignment from each test case
that are clearly and unambiguously aligned. More recently, several new benchmarks
have been proposed, including OXBENCH (Raghava et al., 2003), PREFAB (Edgar,
2004a), SABmark (Van Walle et al., 2005), IRMBASE (Subramanian et al., 2005),
and an extended version of BaliBase (BaliBase 3, available at http://www-bio3d-
igbmc.u-strasbg.fr/balibase/). These new test cases have generally been constructed
by automatic means implying that the overall quality and accuracy of an individual
alignment cannot be guaranteed. However, averaging accuracy scores over a large
set of such alignments can still result in a meaningful ranking of multiple alignment
tools.

3.8 Which program to choose?

Validation of multiple alignment programs using benchmark data sets provides
useful information about their biological accuracy. Although this generally is of
major concern, it is not the only criterion for choosing a particular software tool.
Execution time and memory usage, in particular, can be limiting factors in practice.
This is the main drawback of programs that achieve high accuracy, like T-Coffee
and ProbCons. It is interesting to note that ClustalW is still relatively memory
efficient compared with modern programs.

As a guideline to choosing alignment programs, we follow here the recommen-
dations made by Edgar and Batzoglou (2006), which are summarized in Table 3.2.
Because multiple alignment is an ongoing and active research field, these recom-
mendations can evolve relatively rapidly. If accuracy is the only concern, which
is generally the case for limited size data sets, it is recommended to apply dif-
ferent alignment methods and compare the results using the AltAVisT web server
(Morgenstern, 2003).

Incorporation of structural information in protein sequence alignment can
provide significant improvement in alignment accuracy. This has inspired the
development of programs that use such information in an automated fash-
ion, like 3DCoffee (O’Sullivan et al., 2004). The 3DCoffee algorithm has
been implemented in a webserver called Expresso that only requires input
sequences (Armougom et al., 2006). Expresso automatically runs Blast to iden-
tify close homologs of the sequences within the PDB database (see Chapter 2).
These PDB structures are used as templates to guide the alignment of the orig-
inal sequences using structure-based sequence alignment methods. Homology
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Table 3.2 Typical alignment tasks and recommended procedures

Input data Recommendations

2–100 sequences of typical protein length
(maximum around 10 000 residues) that are
approximately globally alignable

Use ProbCons, T-Coffee, and Mafft or Muscle, compare
the results using AltAVisT. Regions of agreement are
more likely to be correct. For sequences with low
percent identity, ProbCons is generally the most
accurate, but incorporating structure information
(where available) via 3DCoffee (a variant of T-Coffee)
can be extremely helpful

100–500 sequences that are approximately
globally alignable

Use Muscle or one of the Mafft scripts with default
options. Comparison using AltAVisT is possible, but the
results are hard to interpret with larger numbers of
sequences unless they are highly similar

>500 sequences that are approximately globally
alignable

Use Muscle with a faster option (we recommend
maxiters-2) or one of the faster Mafft scripts

Large numbers of alignments, high-throughput
pipeline

Use Muscle with faster options (e.g. maxiters-1 or
maxiters-2) or one of the faster Mafft scripts

2–100 sequences with conserved core regions
surrounded by variable regions that are not
alignable

Use Dialign

2–100 sequences with one or more common
domains that may be shuffled, repeated or
absent

Use ProDA

A small number of unusually long sequences (say,
>20 000 residues)

Use ClustalW. Other programs may run out of memory,
causing an abort (e.g. a segmentation fault)

This table is published in Current Opinion in Structural Biology, 16, Edgar R.C. & Batzoglou S., Multiple sequence
alignment, 368–373, Copyright Elsevier (2006).

information is also exploited by Praline (Simossis & Heringa, 2005), which
uses PSI-Blast (see Chapter 2) to retrieve homologs and build profiles for these
sequences. SPEM also builds profiles, and additionally, uses secondary struc-
ture information (Zhou & Zhou, 2005). Cobalt uses pairwise constraints derived
from database searches, in particular from theConserved Domain Database

and Prosite protein motif database, or from user input, and incorporates these
into a progressive multiple alignment (Papadopoulos & Agarwala, 2007). Finally,
Promals uses probabilistic consistency-based scoring applied to progressive align-
ment in combination with profile information from database searches and sec-
ondary structure prediction (Pei & Grishin, 2007). This approach has been shown
to be a particular improvement for highly divergent homologs.

All these programs try to exploit information that does not merely come
from the input sequences, a research direction that deserves more attention
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in the future. In addition, parameter selection needs to be further explored in
alignment tools, as benchmarking results may be sensitive to parameter choices.
Finally, the rapid development of new alignment algorithms remains unmatched
by independent large-scale comparisons of the software implementations, mak-
ing it difficult to make justified recommendations. A recent comparison of
frequently used programs, including ClustalW, Dialign, T-Coffee, Poa, Muscle,
Mafft, ProbCons, Dialign-T and Kalign, indicated that the iterative approach
available in Mafft, and ProbCons were consistently the most accurate, with Mafft
being the faster of the two (Nuin et al., 2006).

3.9 Nucleotide sequences vs. amino acid sequences

Nucleotide sequences may be coding or non-coding. In the former case, they may
code for structural or catalytic RNA species but more commonly for proteins. In
the case of protein-coding genes, the alignment can be accomplished based on
the nucleotide or amino acid sequences. This choice may be biased by the type of
analysis to be carried out after alignment (Chapter 9); for example, silent changes
in closely related sequences may be counted. In this case, an amino acid alignment
will not be of much use for later analysis. By contrast, if the sequences are only
distantly related, an analysis of amino acid or of nucleotide differences can be per-
formed. Regardless of the end analysis desired, amino acid alignments are easier
to carry out and less ambiguous than nucleotide alignments, which is also true for
sequence database searching (Chapter 2). Another disadvantage of nucleotide align-
ment is that most programs do not recognize a codon as a unit of sequence
and can break up the reading frame during alignment. Particular two-sequence
alignment and database search programs can be exceptions (e.g. Searchwise and
Pairwise by Birney et al., 1996). A typical approach is to carry out the align-
ment at the amino acid level and to then use this to generate a correspond-
ing nucleotide sequence alignment. Different computer programs are available
to perfom such an analysis; for example, Protal2dna by Catherine Letondal:
http://bioweb.pasteur.fr/seqanal/interfaces/protal2dna.html, RevTrans (Wernersen &
Pedersen, 2003), transAlign (Bininda-Emonds, 2005) or Dambe (Xia & Xie 2001; see
Chapter 20).

If the sequences are not protein coding, then the only choice is to carry out
a nucleotide alignment. If the sequences code for structural RNA (e.g. small
sub-unit ribosomal RNA [SSU rRNA]), these will be constrained by function
to conserve primary and secondary structure over at least some of their lengths.
Typically, there are regions of clear nucleotide identity interspersed by regions
that are free to change rapidly. The performance of automatic software depends
on the circumstances, but specific algorithms are being developed (e.g. Murlet;
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Kiryu et al., 2007). With rRNA, the most commonly used programs manage to
align the large conserved core sections, which are conserved across very broad
phylogenetic distances. These core alignment blocks, however, will be interspersed
by the highly variable expansion segments; most programs have difficulties with
them. Consideration of the secondary structures, perhaps using a dedicated RNA
editor, can help but it may still be difficult to find an unambiguous alignment.
Excluding these regions from further analysis should be seriously considered; if
the alignment is arbitrary, further analysis would be meaningless anyway. Fortu-
nately, there are usually enough clearly conserved blocks of alignment to make a
phylogenetic analysis possible.

If the nucleotide sequences are non-coding (e.g. SINES or introns), then align-
ment may be difficult once the sequences diverge beyond a certain level. Sequences
that are highly unconstrained can accumulate indels and substitutions in all posi-
tions; these rapidly become unalignable. There is no algorithmic solution and
the situation will be especially difficult if the sequences have small repeats (see
Section 3.2). Even if a “somewhat optimal” alignment is obtained using a particu-
lar alignment score or parsimony criterion, there may be no reason to believe it is
biologically reasonable. Such scores are based on arbitrary assumptions about the
details of the evolutionary processes that have shaped the sequences. Even if the
details of the assumptions are justifiable, the alignment may be so hidden that it
has become unrecoverable. Caution should be taken if one alignment cannot be
justified over an alternative one.

3.10 Visualizing alignments and manual editing

Although there is a continuous effort to improve biological accuracy of multiple
alignment tools, manually refined alignments remain superior to purely auto-
mated methods. This will be particularly the case when manual editing takes
advantage of additional knowledge (other than sequence data), which is difficult
to take into account automatically (although see 3DCoffee, Praline and SPem in
Section 3.8). Manual editing is necessary to correct obvious alignment errors and
to remove sections of dubious quality. Analogous to automatic alignment, manual
editing should be performed on the amino acid level for protein coding sequences.
In this way, information about protein domain structure, secondary structure,
or amino acid physicochemical properties can be taken into consideration. In
Chapter 9, some general recommendations for manual adjustment of a protein
alignment are presented.

After refinement, regions that are still aligned unambiguously need to be deleted
and a decision needs to be made on how to handle gaps. Not necessarily all positions
with gaps need to be discarded (often referred to as “gap stripping”) because they
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can still contain useful information. If the gaps have been inserted unambiguously
and the alignment columns are not overly gapped, preferably less than 50%, they
can be kept in the alignment. By unambiguous, we mean that it is obvious that a
gap needs to be inserted in a particular column rather than the preceding or the
following one to recover the true positional homology. The way the information in
gapped columns is used in phylogenetic analysis depends on the inference method.
Distance-based methods (Chapter 5) either ignore all sites that include gaps or
missing data (complete deletion) or compute a distance for each pair of sequences
ignoring only gaps in the two sequences being compared (pairwise deletion). In
likelihood analysis (Chapters 6 and 7), gaps are generally treated as unknown
characters. So, if a sequence has a gap at a particular site, then that site simply has
no information about the phylogenetic relationships of that sequence, but it can still
contribute information about the phylogenetic relationships of other sequences.

There are several software programs available for manual editing, visualizing and
presenting alignments. A detailed software review is available online at the webpage
of the Pasteur Institute (http://bioweb.pasteur.fr/cgi-bin/seqanal/review-edital.pl). In
Table 3.3, we present a selection of some useful, user-friendly alignment editors
with a brief description of their specific features, their availability, and the operating
system on which they can be run. Although editors are useful tools in sequence
analysis, funding and/or publication is not always obvious. As a consequence,
researchers may sometimes need to resort to well-maintained and supported
commercial software packages.



PRACTICE
Des Higgins and Philippe Lemey

In this practical exercise, we will align TRIM5α gene sequences from different
primate species. TRIM5α is a retroviral restriction factor that protects most Old
World monkey cells against HIV infection. This data set was originally analyzed
by Sawyer et al. (2005), and is also used in the practical exercise on molecular
clock analysis (Chapter 11). We will employ progressive alignment (ClustalX),
consistency-based scoring (T-Coffee) and iterative refinement (Muscle) to cre-
ate different protein alignments and compare the results using the AltAVisT web
server. The exercise is designed to cover a program with a graphical user interface,
a webserver and a command-line program. We will align the sequences at the
amino acid level, compare different alignment algorithms, generate a correspond-
ing nucleotide alignment and manually refine the result. Both the amino acid and
nucleotide sequences (“primatesAA.fasta” and “primatesNuc.fasta,” respectively)
are available for download at www.thephylogenetichandbook.org.

3.11 Clustal alignment

3.11.1 File formats and availability
As discussed in the previous chapter, the most common file formats are Genbank,
EMBL, SWISS-PROT, FASTA, PHYLIP, NEXUS, and Clustal. The database formats
Genbank, EMBL, and SWISS-PROT are typically used for a single sequence and
most of each entry is devoted to information about the sequence. These are generally
not used for multiple alignment. Nonetheless, Clustal can read these formats and
write out alignments (including gaps, “-”) in different formats, like PHYLIP and
Clustal, used exclusively for multiple alignments. In fact, Clustal programs can be
used as alignment converters, being able to read sequence files in the following
formats: NBRF/PIR, EMBL/SWISS-PROT, FASTA, GDE, Clustal, GCG/MSF and
NBRF/PIR; and write alignment files in all of the following formats: NBRF/PIR,
GDE, Clustal, GCG/MSF and PHYLIP.

ClustalW and ClustalX are both freely available and can be down-
loaded from the EMBL/EBI file server (ftp://ftp.ebi.ac.uk/pub/software/) or
from ICGEB in Strasbourg, France (ftp://ftp-igbmc.u-strasbg.fr/pub/ClustalW/
and ftp://ftp-igbmc.u-strasbg.fr/pub/ClustalX/). These sites are also accessi-
ble through the phylogeny programs website maintained by Joe Felsenstein
(http://evolution.genetics.washington.edu/phylip/software.html). The programs are
available for PCs running MSDOS or Windows, Macintosh computers, VAX
VMS and for Unix/Linux. In each case, ClustalX (X stands for X windows) provides
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a graphical user interface with colorful display of alignments. ClustalW has an older,
text-based interface and is less attractive for occasional use. Nonetheless, it does
have extensive command line facilities making it extremely useful for embedding
in scripts for high-throughput use. The Clustal algorithm is also implemented in
a number of commercial packages.

Clustal is also directly accessible from several servers across the Internet, which
is especially attractive for occasional users, but it is not without drawbacks.
First, users generally do not have access to the full set of features that Clustal
provides. Second, it can be complicated to send and retrieve large numbers of
sequences or alignments. Third, it can take a long time to carry out large align-
ments with little progress indication; there may even be a limit on the number
of sequences that can be aligned. Nonetheless, excellent Clustal servers can be
recommended at EBI (http://www.ebi.ac.uk/clustalw/) and BCM search launcher at
http://searchlauncher.bcm.tmc.edu/.

3.11.2 Aligning the primate Trim5α amino acid sequences
Download the primatesAA.fasta file from the website accompanying the phylo-
genetic handbook (http://www.thephylogenetichandbook.org), which contains 22
primate Trim5α amino acid sequences in fasta format. Open ClustalX and open the
sequence file using File → Load Sequences. The graphical display allows
the user to slide over the unaligned protein sequences. Select Do complete

Alignment from the Alignment menu. ClustalX performs the progressive
alignment (progress can be followed up in the lower left corner), and creates an
output guide tree file and an output alignment file in the default Clustal for-
mat. It is, however, possible to choose a different format in the Output Format

Options from the Alignment menu, such as, for example, the Phylip format
which, in contrast to Clustal, can be read by many of the phylogeny packages.
The file with “.dnd” extension contains the guide tree generated by ClustalX in
order to carry out the multiple alignment (see Section 3.6.1). Note that the guide
tree is a very rough phylogenetic tree and it should not be used to draw conclusions
about the evolutionary relationships of the taxa under investigation! ClustalX also
allows the user to change the alignment parameters (from Alignment Param-

eters in the Alignment menu). Unfortunately, there are no general rules for
choosing the best set of parameters, like the gap-open penalty or the gap-extension
penalty. If an alignment shows, for example, too many large gaps, the user can
try to increase the gap-opening penalty and redo the alignment. ClustalX indi-
cates the degree of conservation at the bottom of the aligned sequences, which
can be used to evaluate a given alignment. By selecting Calculate Low-

Scoring Segment and Show Low-Scoring Segments from the Qual-
ity menu, it is also possible to visualize particularly unreliable parts of the
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alignment, which may be better to exclude from the subsequent analyses. As noted
in Section 3.9, the user should keep in mind that alignment scores are based
on arbitrary assumptions about the details of the evolutionary process and are
not always biologically plausible. Save the amino acid alignment using File →
Save Sequences as and selecting FASTA output format, which automatically
saves the file with fasta extension to the directory that contains the input file (and
may thus overwrite the input file).

3.12 T-Coffee alignment

Although standalone T-Coffee software is also available for different operating
systems (Windows, Unix/linux, and MacosX), we will perform the consistency-
based alignment using the T-Coffee webserver in this exercise (available at
http://www.tcoffee.org/). We select the regular submission form that only requires
us to upload the “primatesAA.fasta” file or paste the sequences in the sub-
mission window. An email notification with a link to the results page will be
sent if the email address is filled in, but this is not required. As noted above,
T-Coffee computations are more time-consuming than Clustal progressive align-
ment. A job submitted on the webserver should take less than 2 minutes to
complete. When the alignment procedure is completed, a new page will appear
with links to the output files. Save the alignment in fasta format to your desktop
(e.g. as “primatesAA tcoffee.fas”). The score pdf file contains a nicely quality-
colored alignment in pdf format; the same output is presented in an html
file.

3.13 Muscle alignment

To compute an iteratively refined alignment, we will use the standalone
Muscle software, available for Windows, Unix/linux, and MacosX at http://
www.drive5.com/. Muscle is a command-line program and thus requires the
use of a terminal (Unix/Linux/MacosX) or a DOS-Window on a Windows
operating system. Copy the input file (“primatesAA.fasta”) to the Muscle
folder, open a terminal/DOS-Window and go to the Muscle folder (using
“cd”). To execute the program type muscle −in primatesAA.fasta

−out primatesAA muscle.fasta. In a DOS-Window the executable with
extension needs to be specified: muscle.exe −in primatesAA.fasta

−out primatesAA muscle.fasta. The program completes the align-
ment procedure in a few seconds and writes out the outfile in fasta format
(“primatesAA muscle.fasta”).
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3.14 Comparing alignments using the AltAVisT web tool

To evaluate results obtained using the different alignment algorithms, we use
a simple and user-friendly WWW-based software program called AltAVisT
(http://bibiserv.techfak.uni-bielefeld.de/altavist/). AltAVisT compares two alterna-
tive multiple alignments and uses different color-codes to indicate local agreement
and conflict. The regions where both alignments coincide are generally considered
to be more reliable than regions where they disagree. This is similar to the reasoning
that clusters present in phylogenetic trees, reconstructed by various algorithms, are
more reliable than clusters that are not consistently present. A color printout of the
result pages obtained for the following alignment comparisons will be useful for
further manual editing in Section 3.16.

Go to the AltAVisT webserver and click on OPTION 2: Enter two dif-

ferent pre-calculated alignments of a multiple sequence

set. Upload or paste the alignments generated by ClustalX and T-Coffee, enter the
title “ClustalX” and “T-Coffee,” respectively and click submit. In the results page,
the two alignments are shown with colored residues (several parts of this alignment
are shown in Fig. 3.9). When all residues in a single column are shown in the same
color, which is the case for the first 46 columns, these residues are lined up in the
same way in both alignments. If a residue has a different color, e.g. the arginine
“R” for “Howler” in column 52, it is aligned differently in the second alignment
(in column 47 instead of 52). The same is true for the glutamic acid residues
“E” in the second block (column 89). With respect to column 89 and 90, there
is no obvious reason to prefer the first or second alignment since the total align-
ment score for these columns is the same and phylogenetic inference would not be
influenced.

Different colors are used to distinguish groups of residues where the alignment
coincides within groups but not between different groups. An example of this can
be observed in the sixth alignment block (column 342–343; Fig. 3.9): the “LT”
residues in AGM, Tant cDNA and AGM cDNA are aligned by ClustalX as well
as T-Coffee, but not with the same residues from the other taxa. Also the “PS”
residues in Rhes cDNA and baboon are in common columns in the two alignments,
but not aligned with the same residues (e.g. not with the “LT” residues from AGM,
Tant cDNA, and AGM cDNA in the second alignment), explaining why they have
different color-code. In the second alignment, all residues have the same color as
in the first alignment allowing straightforward comparison of the two alignments.
The color-coded comparison reveals that large blocks of alignment discrepancies
are concentrated close to gapped regions. So, if gapped regions are to be stripped
from this alignment, it is recommended also to delete the neighboring ambiguously
aligned columns. The same comparison for the ClustalX and Muscle alignments
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Human M..SMLDK-GE..PE-G..PKPQIIYGARGTRYQTFV--------------------N..QPDAMCNI
Chimp M..SMLDK-GE..PE-G..PKPQIIYGARGTRYQTFM--------------------N..QPDAMCNI
Gorilla M..SMLDK-GE..PE-G..PKPQIIYGAQGTRYQTFM--------------------N..QPDATCNI
Orangutan M..STLDK-GE..PE-G..PEPQIIYGAQGTTYQTYV--------------------N..QPDAMYNI
Gibbon M..SMPDE-GE..PEEG..PEPQIIFEAQGTISQTFV--------------------N..QPDAMYNI
AGM M..SMLYKEEE..PEEG..QNPQIMYQAPGSSFGSLTNFNYCTGVLGSQSITSRKLTN..QPDATYNI
Tant_cDNA M..SMLYKEEE..PEEG..QNPQIMYQAPGSSFGSLTNFNYCTGVLGSQSITSRKLTN..QPDATYNI
AGM_cDNA M..SMLYKEEE..PEEG..RNPQIMYQSPGSLFGSLTNFSYCTGVPGSQSITSGKLTN..QPDATYNI
Rhes_cDNA M..SMLYKEGE..PEEG..RNPQIMYQAPGTLFTFPS------------------LTN..QSDAMYNI
Baboon M..SMLYKEGE..PEEG..RNPQITYQAPGTLFSFPS------------------LTN..QPDAMYNI
Patas M..SMLYKEEE..PEEG..RNPQIMYWAQGKLFQSLK--------------------N..QPDAMYDV
Colobus M..SMLYKEGE..PEEG..PNPQIMYRAQGTLFQSLK--------------------N..QPDAMYNI
DLangur M..SMLYKEGE..PEEG..PNPQIMCRARGTLFQSLK--------------------N..QPDAMYNI
PMarmoset M..STLHQ-GE..PEEG..Q-VPI-HQPLV---------------------------K..KCNAKWNV
Tamarin M..STPHQ-GE..PEEG..Q-FQI-HQPSV---------------------------K..KCNAKWNV
Owl M..SMPHQ-GE..PEEG..Q-KRI-YQPFL---------------------------K..KRTASCSV
Squirrel M..SMLHQ-GE..PEER..Q-KPI-RHLLV---------------------------K..KCTANQSV
Titi M..STLHQ-GE..PEEG..Q-EWI-HQSSG---------------------------R..KCAANRNG
Saki M..SMLHQ-GE..PEEG..Q-ERI-HQSFG---------------------------K..KCTANRNG
Spider M..STLHQ-GE..PEEG..Q-EQI-HQPSV---------------------------K..KCTAN--V
Woolly M..STLHQ-GE..PEEG..Q-KQR-HRPSV---------------------------K..KCTAN--V
Howler M..S-----RE..PEEG..Q-EQIHHHPSM---------------------------E..KCIGN--F

| | | | | | | | |
                             1     47             52   88    91   325                                                                                      463  402          409  

Fig. 3.9 Parts of the TRIM5α ClustalX alignment coloured by AltAVisT. The colours are based on the
comparison between ClustalX and T-Coffee. The different parts of the alignment shown are
interspersed with two dots; the position of the start and end of the column of each part are
indicated at the bottom.

reveals very similar discrepancies. Not surprisingly, there are fewer differences
between the T-Coffee and Muscle alignments. We will use this information when
manually editing the sequence alignment (Section 3.16).

3.15 From protein to nucleotide alignment

All three programs discussed above frequently break up the coding reading frame
when aligning the TRIM5α nucleotide sequences. This would invalidate further
codon-based analysis, e.g. inference of positively selected sites like originally per-
formed on this data set (Sawyer et al., 2005; see also Chapter 14), and extensive
manual editing would be required to restore the reading frame. To avoid this, the
protein alignment can be used to generate a corresponding nucleotide sequence
alignment. This procedure also takes advantage of the fact that protein alignments
are less ambiguous and faster to compute.

We will create a TRIM5α nucleotide alignment using the Protal2dna web-
application available at http://bioweb.pasteur.fr/seqanal/interfaces/protal2dna.html.
Go to WWW-submission form and enter your email address. Upload the ClustalX
protein alignment and the unaligned nucleotide sequences (“primatesNuc.fasta,”
available at www.phylogenetichandbook.org). Because the order in which sequences
appear in both files may be different, select the option identify cor-

responding DNA sequences by same ID or name (-i). Select the
Pearson/Fasta Output Alignment format and run the application.
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Save the output file “protal2DNA.out” to your computer and change the name
to “primatesNuc pro2DNA.fasta.”

The complete procedure of aligning protein sequences and generating the cor-
responding nucleotide alignment can also be performed in an automated fashion
using programs like RevTrans, transAlign and Dambe. We will briefly discuss how to
do this using Dambe, a feature-rich PC program for data analysis in molecular biol-
ogy (http://dambe.bio.uottawa.ca/software.asp), assuming a fully working version
of the program is installed on your PC.

(i) Copy the “primatesNuc.fasta” file to the Dambe folder, run DAMBE.exe, and
open the file by choosing Open standard sequence file from the File
menu. The window “Open” appears: set the Files of type option to
Pearson/Fasta, browse to the Dambe folder and open “primatesNuc.phy.”

(ii) In the “Sequence Info” window, select Protein-coding Nuc. Seqo and
keep the standard genetic code. Click the Go! button.

(iii) Select Work on Amino Acid Sequence from the Sequences menu

and confirm that all sequences have a complete start codon.
(v) Select Align Sequences Using ClustalW from the Alignment menu,

keep default settings and Click the Go! button.
(vi) When the protein alignment is completed select Align Nuc. Seq. to

aligned AA seq. in buffer from the Alignment menu. Have a look
at the requirements for the back-translation and proceed by opening the original
“primatesNuc.fasta” file. The corresponding nucleotide alignment can be saved in
different output formats by selecting Save or Convert Sequence For-

mat from the File menu. Note that Dambe has several automated features to
delete gapped columns or other parts of the alignment using the Get Rid of

Segment option in the Sequences menu.

3.16 Editing and viewing multiple alignments

As recommended in Section 3.10, we will edit the alignment at the amino acid
level. However, if we wish to perform further analysis on the nucleotide sequences,
it would be preferable to edit the nucleotide alignment by making changes in the
appropriate amino acid translation mode. Two editors allowing the user to flexibly
toggle between nucleotides and amino acids while making changes to the alignment
are BioEdit for Windows and Se-Al for MacOS. We will now briefly discuss how
to delete ambiguously aligned regions in the coding gene alignment based on the
AltAVisT comparisons and provide some basic instructions for using either BioEdit
or Se-Al.

Open the coding gene alignment “primatesNuc pro2DNA.fasta” obtained by the
PROTAL2DNAweb-application (BioEdit&Se-AL:File → Open; Note that
shortcut keys are available for both programs). Changing the background colour
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can make the view more clear (BioEdit: View → View Mode → Inverse

Background Colored; Se-Al: Alignment → Use Block Colours).
Switch to amino acid translation (BioEdit: Ctrl+A to select all sequences,
Sequence → Toggle Translation or Ctrl+G; Se-Al: Alignment

→ Alignment Type → Amino Acid or command+T).
The first alignment ambiguity indicated by the AltAVisT comparisons is situated

in columns 47 to 52, where different algorithms did not agree how to align the
arginine “R” for “Howler” (Fig. 3.9). The most conservative option here would
be to delete these six columns all together. In both programs, these columns can
be selected by click-dragging the mouse over the relevant alignment region. In
Se-Al, the columns can simply be deleted using Edit → Cut or command-X
(Fig. 3.10). In BioEdit, we need to switch to the Edit mode in the alignment
window menu (Fig. 3.10), and revert (Ctrl+G) to the nucleotide sequences. No
direct editing on the amino acid translation is allowed, but our selection remains
in the nucleotide view and can be deleted using Edit → Cut or Ctrl-X. Note
that Se-Al can only “undo” the last action, whereas BioEdit does not have this
limitation. The next alignment differences were indicated in columns 89 and 90.
However, as discussed above, the differences are, in fact, equivalent for phyloge-
netic inference and no editing is required for this purpose. Based on the ambiguities
indicated by AltAVisT (both ClustalX vs. T-Coffee and ClustalX vs. Muscle) and
the presence of highly gapped columns, the alignment regions that should prefer-
ably be deleted are 47–52, 326–362, 403–408 and 425–511 (numbering according
to the protein translation of “primatesNuc pro2DNA.fasta”). The first three of
these regions are shown in Fig. 3.9. When these regions are being deleted from the
beginning of the aligment the numbering will change to 47–52, 320–356, 360–365
and 376–462. The edited alignments can now be saved to your computer in dif-
ferent formats (BioEdit: File → Save As ... or File → Export →
Sequence Alignment; Se-Al: File → Export or command+E). A file
with the modified alignment has been made available to check whether the correct
editing was performed.

In this exercise, editing was restricted to deleting unreliable regions. This will
be the case in many real-world alignment situations. However, considering only
a single alignment, it can be necessary to correct obvious alignment errors. Both
programs have extensive facilities to perform these refinements using select and
slide, grab and drag, copy, cut, and paste functions.

3.17 Databases of alignments

In the future, it will become more clear how many different protein and RNA
sequence families actually exist, and large alignments of these will be available
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Fig. 3.10 Screen shots of BioEdit and Se-Al. In both programs, the protein coding alignment is loaded,
translated to amino acids, and the columns 47 to 52 are selected. In BioEdit, the Mode is
being switched to Edit; in Se-Al, the columns are being deleted.

through computer networks. In the meantime, huge alignments for the biggest and
most complicated families (rRNA) already exist, which are maintained and updated
regularly (http://www.psb.ugent.be/rRNA/). Also databases for specific organisms
with alignments are being maintained (e.g. HIV: http://www.hiv.lanl.gov/). In
this context, it is interesting to note that programs like Clustal have utili-
ties to align sequences or alignments against pre-built alignments. There are
numerous databases of protein alignments, each with different advantages and
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disadvantages, different file formats, etc. The situation is settling down with the
Interpro project (http://www.ebi.ac.uk/interpro/index.html), which aims to link
some of the biggest and most important protein family databases. Interpro is
an invaluable resource for obtaining detailed information on a family of interest
and for downloading sample alignments. These alignments can be used as the
basis for further phylogenetic work or simply for educational or informational
purposes.


	Half-title
	Title
	Copyright
	Contents
	Contributors
	Foreword
	Preface
	Section I: Introduction
	1 Basic concepts of molecular evolution
	1.1 Genetic information
	1.2 Population dynamics
	1.3 Evolution and speciation
	1.4 Data used for molecular phylogenetics
	1.5 What is a phylogenetic tree?
	1.6 Methods for inferring phylogenetic trees
	1.7 Is evolution always tree-like?
	Further reading


	Section II: Data preparation
	2 Sequence databases and database searching
	THEORY
	2.1 Introduction
	2.2 Sequence databases
	2.2.1 General nucleic acid sequence databases
	Entry name, locus name or identifier (ID)
	Accession number (AC)
	Version number
	GenInfo number (GenBank only)
	Whole Genome Shotgun (WGS) sequences
	Third Party Annotations (TPA)

	2.2.2 General protein sequence databases
	2.2.3 Specialized sequence databases, reference databases, and genome databases

	2.3 Composite databases, database mirroring and search tools
	2.3.1 Entrez
	2.3.2 Sequence Retrieval System (SRS)
	2.3.3 Some general considerations about database searching by keyword

	2.4 Database searching by sequence similarity
	2.4.1 Optimal alignment
	2.4.2 Basic Local Alignment Search Tool (Blast)
	2.4.3  FastA
	2.4.4 Other tools and some general considerations

	PRACTICE
	2.5 Database searching using ENTREZ
	2.6 Blast
	2.7 FastA

	3 Multiple sequence alignment
	THEORY
	3.1 Introduction
	3.2 The problem of repeats
	3.3 The problem of substitutions
	3.4 The problem of gaps
	3.5 Pairwise sequence alignment
	3.5.1 Dot-matrix sequence comparison
	3.5.2 Dynamic programming

	3.6 Multiple alignment algorithms
	3.6.1 Progressive alignment
	Clustal

	3.6.2 Consistency-based scoring
	T-Coffee

	3.6.3 Iterative refinement methods
	3.6.4 Genetic algorithms
	3.6.5 Hidden Markov models
	3.6.6 Other algorithms

	3.7 Testing multiple alignment methods
	3.8 Which program to choose?
	3.9 Nucleotide sequences vs. amino acid sequences
	3.10 Visualizing alignments and manual editing
	PRACTICE
	3.11 Clustal alignment
	3.11.1 File formats and availability
	3.11.2 Aligning the primate Trim5alpha amino acid sequences

	3.12 T-Coffee alignment
	3.13 Muscle alignment
	3.14 Comparing alignments using the AltAVisT web tool
	3.15 From protein to nucleotide alignment
	3.16 Editing and viewing multiple alignments
	3.17 Databases of alignments


	Section III: Phylogenetic inference
	4 Genetic distances and nucleotide substitution models
	THEORY
	4.1 Introduction
	4.2 Observed and expected distances
	4.3 Number of mutations in a given time interval (optional)
	4.4 Nucleotide substitutions as a homogeneous Markov process
	4.4.1 The Jukes and Cantor (JC69) model

	4.5 Derivation of Markov Process (optional)
	4.5.1 Inferring the expected distances

	4.6 Nucleotide substitution models
	4.6.1 Rate heterogeneity among sites

	PRACTICE
	4.7 Software packages
	4.8 Observed vs. estimated genetic distances: the JC69 model
	4.9 Kimura 2-parameter (K80) and F84 genetic distances
	4.10 More complex models
	4.10.1 Modeling rate heterogeneity among sites

	4.11 Estimating standard errors using Mega4
	4.12 The problem of substitution saturation
	4.13 Choosing among different evolutionary models

	5 Phylogenetic inference based on distance methods
	THEORY
	5.1 Introduction
	5.2 Tree-inference methods based on genetic distances
	5.2.1 Cluster analysis (UPGMA and WPGMA)
	5.2.2 Minimum evolution and neighbor-joining
	5.2.3 Other distance methods

	5.3 Evaluating the reliability of inferred trees
	5.3.1 Bootstrap analysis
	5.3.2 Jackknifing

	5.4 Conclusions
	PRACTICE
	5.5 Programs to display and manipulate phylogenetic trees
	5.6 Distance-based phylogenetic inference in Phylip
	5.7 Inferring a Neighbor-Joining tree for the primates data set
	5.7.1 Outgroup rooting

	5.8 Inferring a Fitch-Margoliash tree for the mtDNA data set
	5.9 Bootstrap analysis using Phylip
	5.10 Impact of genetic distances on tree topology: an example using Mega4
	5.11 Other programs

	6 Phylogenetic inference using maximum likelihood methods
	THEORY
	6.1 Introduction
	6.2 The formal framework
	6.2.1 The simple case: maximum-likelihood tree for two sequences
	6.2.2 The complex case

	6.3 Computing the probability of an alignment for a fixed tree
	6.3.1 Felsenstein's pruning algorithm

	6.4 Finding a maximum-likelihood tree
	6.4.1 Early heuristics
	6.4.2 Full-tree rearrangement
	6.4.3 DNAML and FASTDNAML
	6.4.4 PHYML and PHYML-SPR
	6.4.5 IQPNNI
	6.4.6 RAXML
	6.4.7 Simulated annealing
	6.4.8 Genetic algorithms

	6.5 Branch support
	6.6 The quartet puzzling algorithm
	6.6.1 Parameter estimation
	6.6.2 ML step
	6.6.3 Puzzling step
	6.6.4 Consensus step

	6.7 Likelihood-mapping analysis
	PRACTICE
	6.8 Software packages
	6.9 An illustrative example of an ML tree reconstruction
	6.9.1 Reconstructing an ML tree with IQPNNI
	6.9.2 Getting a tree with branch support values using quartet puzzling
	6.9.3 Likelihood-mapping analysis of the HIV data set

	6.10 Conclusions

	7 Bayesian phylogenetic analysis using MRBAYES
	THEORY
	7.1 Introduction
	7.2 Bayesian phylogenetic inference
	7.3 Markov chain Monte Carlo sampling
	7.4 Burn-in, mixing and convergence
	7.5 Metropolis coupling
	7.6 Summarizing the results
	7.7 An introduction to phylogenetic models
	7.8 Bayesian model choice and model averaging
	7.9 Prior probability distributions
	PRACTICE
	7.10 Introduction to MRBAYES
	7.10.1 Acquiring and installing the program
	7.10.2 Getting started
	7.10.3 Changing the size of the MRBAYES window
	7.10.4 Getting help

	7.11 A simple analysis
	7.11.1 Quick start version
	7.11.2 Getting data into MRBAYES
	7.11.3 Specifying a model
	7.11.4 Setting the priors
	7.11.5 Checking the model
	7.11.6 Setting up the analysis
	7.11.7 Running the analysis
	7.11.8 When to stop the analysis
	7.11.9 Summarizing samples of substitution model parameters
	7.11.10 Summarizing samples of trees and branch lengths

	7.12 Analyzing a partitioned data set
	7.12.1 Getting mixed data into MRBAYES
	7.12.2 Dividing the data into partitions
	7.12.3 Specifying a partitioned model
	7.12.4 Running the analysis
	7.12.5 Some practical advice


	8 Phylogeny inference based on parsimony and other methods using Paup
	THEORY
	8.1 Introduction
	8.2 Parsimony analysis – background
	8.3 Parsimony analysis – methodology
	8.3.1 Calculating the length of a given tree under the parsimony criterion

	8.4 Searching for optimal trees
	8.4.1 Exact methods
	8.4.2 Approximate methods

	PRACTICE
	8.5 Analyzing data with Paup through the command-line interface
	8.6 Basic parsimony analysis and tree-searching
	8.7 Analysis using distance methods
	8.8 Analysis using maximum likelihood methods

	9 Phylogenetic analysis using protein sequences
	THEORY
	9.1 Introduction
	9.2 Protein evolution
	9.2.1 Why analyze protein sequences?
	9.2.2 The genetic code and codon bias
	9.2.3 Look-back time
	9.2.4 Nature of sequence divergence in proteins (the PAM unit)
	9.2.5 Introns and non-coding DNA
	9.2.6 Choosing DNA or protein?

	9.3 Construction of phylogenetic trees
	9.3.1 Preparation of the data set
	Retrieval of protein sequences
	Alignment of two-protein sequences
	Multiple sequence alignment
	Manual adjustment of a protein alignment

	9.3.2 Tree-building
	Methods for inferring a protein phylogeny
	Rooting a tree
	Reliability of tree topologies


	PRACTICE
	9.4 A phylogenetic analysis of the Leishmanial glyceraldehyde-3-phosphate dehydrogenase gene carried out via the Internet
	9.5 A phylogenetic analysis of trypanosomatid glyceraldehyde-3-phosphate dehydrogenase protein sequences using Bayesian inference


	Section IV: Testing models and trees
	10 Selecting models of evolution
	THEORY
	10.1 Models of evolution and phylogeny reconstruction
	10.2 Model fit
	10.3 Hierarchical likelihood ratio tests (hLRTs)
	10.3.1 Potential problems with the hLRTs

	10.4 Information criteria
	10.5 Bayesian approaches
	10.6 Performance-based selection
	10.7 Model selection uncertainty
	10.8 Model averaging
	PRACTICE
	10.9 The model selection procedure
	10.10 Model Test
	10.11 ProtTest
	10.12 Selecting the best-fit model in the example data sets
	10.12.1 Vertebrate mtDNA
	10.12.2 HIV-1 envelope gene
	10.12.3 G3PDH protein


	11 Molecular clock analysis
	THEORY
	11.1 Introduction
	11.2 The relative rate test
	11.3 Likelihood ratio test of the global molecular clock
	11.4 Dated tips
	11.5 Relaxing the molecular clock
	11.6 Discussion and future directions
	PRACTICE
	11.7 Molecular clock analysis using Paml
	11.8 Analysis of the primate sequences
	11.9 Analysis of the viral sequences

	12 Testing tree topologies
	THEORY
	12.1 Introduction
	12.2 Some defnitions for distributions and testing
	12.3 Likelihood ratio tests for nested models
	12.4 How to get the distribution of likelihood ratios
	12.4.1 Non-parametric bootstrap
	12.4.2 Parametric bootstrap

	12.5 Testing tree topologies
	12.5.1 Tree tests - a general structure
	12.5.2 The original Kishino-Hasegawa (KH) test
	12.5.3 One-sided Kishino-Hasegawa test
	12.5.4 Shimodaira-Hasegawa (SH) test
	12.5.5 Weighted test variants
	12.5.6 The approximately unbiased (AU) test
	12.5.7 Swofford-Olsen-Waddell-Hillis (SOWH) test

	12.6 Confdence sets based on likelihood weights
	12.7 Conclusions
	PRACTICE
	12.8 Software packages
	12.9 Testing a set of trees with Tree-Puzzle and Consel
	12.9.1 Testing and obtaining site-likelihood with Tree-Puzzle
	12.9.2 Testing with CONSEL

	12.10 Conclusions


	Section V: Molecular adaptation
	13 Natural selection and adaptation of molecular sequences
	13.1 Basic concepts
	13.2 The molecular footprint of selection
	13.2.1 Summary statistic methods
	13.2.2 dN/dS methods
	13.2.3 Codon volatility

	13.3 Conclusion

	14 Estimating selection pressures on alignments of coding sequences
	THEORY
	14.1 Introduction
	The unit of evolution
	Estimating the neutral expectation
	Taking phylogenies into account
	Different types of selection

	14.2 Prerequisites
	14.3 Codon substitution models
	14.4 Simulated data: how and why?
	14.5 Statistical estimation procedures
	14.5.1 Distance-based approaches
	14.5.2 Maximum likelihood approaches
	14.5.3 Estimating dS and dN
	14.5.4 Correcting for nucleotide substitution biases
	Hypothesis testing
	Confidence intervals on parameter estimates

	14.5.5 Bayesian approaches

	14.6 Estimating branch-by-branch variation in rates
	14.6.1 Local vs. global model
	14.6.2 Specifying branches a priori
	14.6.3 Data-driven branch selection

	14.7 Estimating site-by-site variation in rates
	14.7.1 Random effects likelihood (REL)
	Comparing distributions of rates in different genes

	14.7.2 Fixed effects likelihood (FEL)
	14.7.3 Counting methods
	14.7.4 Which method to use?
	14.7.5 The importance of synonymous rate variation

	14.8 Comparing rates at a site in different branches
	14.9 Discussion and further directions
	PRACTICE
	14.10 Software for estimating selection
	14.10.1 Paml
	14.10.2 Adaptsite
	14.10.3 Mega
	14.10.4 HyPhy
	14.10.5 Datamonkey

	14.11 Influenza A as a case study
	14.12 Prerequisites
	14.12.1 Getting acquainted with HyPhy
	14.12.2 Importing alignments and trees
	14.12.3 Previewing sequences in HyPhy
	14.12.4 Previewing trees in HyPhy
	14.12.5 Making an alignment
	14.12.6 Estimating a tree
	14.12.7 Estimating nucleotide biases
	14.12.8 Detecting recombination

	14.13 Estimating global rates
	14.13.1 Fitting a global model in the HyPhy GUI
	14.13.2 Fitting a global model with a HyPhy batch file

	14.14 Estimating branch-by-branch variation in rates
	14.14.1 Fitting a local codon model in HyPhy
	14.14.2 Interclade variation in substitution rates
	14.14.3 Comparing internal and terminal branches

	14.15 Estimating site-by-site variation in rates
	14.15.1 Preliminary analysis set-up
	14.15.2 Estimating beta/alpha
	14.15.3 Single-likelihood ancestor counting (SLAC)
	14.15.4 Fixed effects likelihood (FEL)
	14.15.5 REL methods in HyPhy

	14.16 Estimating gene-by-gene variation in rates
	14.16.1 Comparing selection in different populations
	14.16.2 Comparing selection between different genes

	14.17 Automating choices for HyPhy analyses
	14.18 Simulations
	14.19 Summary of standard analyses
	14.20 Discussion


	Section VI: Recombination
	15 Introduction to recombination detection
	15.1 Introduction
	15.2 Mechanisms of recombination
	15.3 Linkage disequilibrium, substitution patterns, and evolutionary inference
	15.4 Evolutionary implications of recombination
	15.5 Impact on phylogenetic analyses
	15.6 Recombination analysis as a multifaceted discipline
	15.6.1 Detecting recombination
	15.6.2 Recombinant identification and breakpoint detection
	15.6.3 Recombination rate

	15.7 Overview of recombination detection tools
	15.8 Performance of recombination detection tools
	Acknowledgment

	16 Detecting and characterizing individual recombination events
	THEORY
	16.1 Introduction
	16.2 Requirements for detecting recombination
	16.3 Theoretical basis for recombination detection methods
	16.4 Identifying and characterizing actual recombination events
	PRACTICE
	16.5 Existing tools for recombination analysis
	16.6 Analyzing example sequences to detect and characterize individual recombination events
	16.6.1 Exercise 1: Working with Simplot
	16.6.2 Exercise 2: Mapping recombination with Simplot
	16.6.3 Exercise 3: Using the "groups" feature of Simplot
	16.6.4 Exercise 4: Setting up Rdp3 to do an exploratory analysis
	16.6.5 Exercise 5: Doing a simple exploratory analysis with Rdp3
	16.6.6 Exercise 6: Using Rdp3 to refne a recombination hypothesis



	Section VII: Population genetics
	17 The coalescent: population genetic inference using genealogies
	17.1 Introduction
	17.2 The Kingman coalescent
	17.3 Effective population size
	17.4 The mutation clock
	17.5 Demographic history and the coalescent
	17.6 Coalescent-based inference
	17.7 The serial coalescent
	17.8 Advanced topics

	18 Bayesian evolutionary analysis by sampling trees
	THEORY
	18.1 Background
	18.2 Bayesian MCMC for genealogy-based population genetics
	18.2.1 Implementation
	18.2.2 Input format
	18.2.3 Output and results
	18.2.4 Computational performance

	18.3 Results and discussion
	18.3.1 Substitution models and rate models among sites
	18.3.2 Rate models among branches, divergence time estimation, and time-stamped data
	18.3.3 Tree priors
	18.3.4 Multiple data partitions and linking and unlinking parameters
	18.3.5 Defnitions and units of the standard parameters and variables
	18.3.6 Model comparison
	18.3.7 Conclusions

	PRACTICE
	18.4 The Beast software package
	18.5 Running BEAUti
	18.6 Loading the NEXUS fle
	18.7 Setting the dates of the taxa
	18.7.1 Translating the data in amino acid sequences

	18.8 Setting the evolutionary model
	18.9 Setting up the operators
	18.10 Setting the MCMC options
	18.11 Running Beast
	18.12 Analyzing the Beast output
	18.13 Summarizing the trees
	18.14 Viewing the annotated tree
	18.15 Conclusion and resources

	19 Lamarc: Estimating population genetic parameters from molecular data
	THEORY
	19.1 Introduction
	19.2 Basis of the Metropolis-Hastings MCMC sampler
	19.2.1 Bayesian vs. likelihood sampling
	19.2.2 Random sample
	19.2.3 Stability
	19.2.4 No other forces
	19.2.5 Evolutionary model
	19.2.6 Large population relative to sample
	19.2.7 Adequate run time

	PRACTICE
	19.3 The Lamarc software package
	19.3.1 Fluctuate (Coalesce)
	19.3.2 Migrate-N
	19.3.3 Recombine
	19.3.4 Lamarc

	19.4 Starting values
	19.5 Space and time
	19.6 Sample size considerations
	19.7 Virus-specifc issues
	19.7.1 Multiple loci
	19.7.2 Rapid growth rates
	19.7.3 Sequential samples

	19.8 An exercise with Lamarc
	19.8.1 Converting data using the Lamarc fle converter
	19.8.2 Estimating the population parameters
	19.8.3 Analyzing the output

	19.9 Conclusions


	Section VIII: Additional topics
	20 Assessing substitution saturation with Dambe
	THEORY
	20.1 The problem of substitution saturation
	20.2 Steels method: potential problem, limitation, and implementation in Dambe
	20.3 Xias method: its problem, limitation, and implementation in Dambe
	PRACTICE
	20.4 Working with the VertebrateMtCOI.FAS file
	20.5 Working with the InvertebrateEF1a.FAS file
	20.6 Working with the SIV.FAS file
	Acknowledgment

	21 Split networks. A tool for exploring complex evolutionary relationships in molecular data
	THEORY
	21.1 Understanding evolutionary relationships through networks
	21.2 An introduction to split decomposition theory
	21.2.1 The Buneman tree
	21.2.2 Split decomposition

	21.3 From weakly compatible splits to networks
	21.4 Alternative ways to compute split networks
	21.4.1 NeighborNet
	21.4.2 Median networks
	21.4.3 Consensus networks and supernetworks

	PRACTICE
	21.5 The SplitsTree program
	21.5.1 Introduction
	21.5.2 Downloading SplitsTree

	21.6 Using SplitsTree on the mtDNA data set
	21.6.1 Getting started
	21.6.2 The fit index
	21.6.3 Laying out split networks
	21.6.4 Recomputing split networks
	21.6.5 Computing trees
	21.6.6 Computing different networks
	21.6.7 Bootstrapping
	21.6.8 Printing

	21.7 Using SplitsTree on other data sets


	Glossary
	References
	Index

